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Copyright and acknowledgments
This guide is for Freeway 4 Pro.

Copyright © 1997-2005 Softpress Systems Ltd. All rights reserved.

The Freeway software and this documentation are copyright materials. 

No part of the Freeway software may be reproduced, transmitted, 

transcribed, stored in a retrieval system, or translated into any language, 

or computer language, in any form or by any means without the prior 

written permission of Softpress Systems Ltd. Additional copies of this 

guide may be made and distributed provided they include this copyright 

notice.

Softpress Systems Ltd specifically retains title to all Freeway computer 

software. The software described in this guide is furnished under 

a license agreement and may only be installed, used, or copied in 

accordance with the terms of that agreement.

Softpress is a trademark of Softpress Systems Ltd in the United States 

and other countries. Freeway is a trademark of Softpress Systems Ltd, 

which may be registered in some countries. 

Apple, Macintosh, Power Macintosh, and the Mac Logo are registered 

trademarks of Apple Computer Inc. All other product names are 

trademarks, or registered trademarks of their respective owners.

Limitation of liability

The information in this guide is believed to be correct as of the date of 

publication. However, our policy is one of continuous development and 

so the information in this guide is subject to change without notice, and 

does not represent a commitment on the part of Softpress Systems Ltd.

This guide was designed and produced by Human-Computer Interface Ltd,  

http://www.interface.co.uk/

Contact details 
You can reach Softpress Systems using the following contact details:

Softpress Systems Ltd 

First Floor 

25 Hanborough House 

Hanborough Business Park 

Witney, Oxon, OX29 8LH 

United Kingdom

Tel: (+44) 1993 882588 

Fax: (+44) 1993 883970

Web: http://www.softpress.com/ 

Email: info@softpress.com

Assumptions and conventions
To avoid ambiguity this guide adopts the following conventions:

Convention What it means

Bold Identifies a name or label that appears on the 

computer screen. For example: Click the OK button.

Computer Identifies text that you key in at the computer 

keyboard.

c, O, C, 

R

Represent the special keys on the keyboard: 

Control, Option (or Alt), Command, and Return.
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About the Freeway documentation
Getting Started with Freeway

This Getting Started with Freeway guide is the ideal place to start learning 

about how to get the most out of Freeway. It includes an overview of 

Freeway’s unique features and benefits, information about planning 

your site and publishing it on the Web, a guided tour of Freeway’s main 

features, and a series of three tutorials showing how to use Freeway to 

create stunning Web sites.

Using Freeway

The Using Freeway guide provides clear step-by-step instructions for using 

all the main features of Freeway, including setting up, previewing, and 

publishing a site, working with pages, text, graphics, tables, and forms, 

and creating dynamic effects. It is designed to help you translate your 

vision into a complete, fully working Web site. 

Freeway Reference

The Freeway Reference guide is aimed at more advanced Freeway users, 

and provides detailed reference information about advanced Web design 

features that may not be needed by all users. It also provides information 

about migrating from existing sites created in other Web programs, and 

a summary of the Freeway preference panels, palettes, and keyboard 

shortcuts. 

On-line Help

Freeway also includes a comprehensive integrated context-linked on-

line help system which you can use to find information about features 

while you are using the product. This includes the same information as 

provided in the Using Freeway and Freeway Reference guides.

The KnowledgeBase

The Softpress Web site also provides an advanced KnowledgeBase 

containing a wide range of information on every aspect of using Freeway, 

including technical notes on specific features, tutorials illustrating how to 

achieve particular effects, answers to frequently asked questions, and 

examples of sites created by third-party designers using Freeway. The 

knowledge base is fully searchable and is being extended on a weekly 

basis to provide answers to any question that users ask about Freeway. 



Welcome to Freeway, the Web authoring program 

that provides the most natural way to realize your 

vision on the Web! Whether you are new to Web 

site design, or an experienced designer, Freeway 

provides the tools you need to achieve impressive 

results with the minimum of effort. 
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How Freeway works
Traditionally, Web site design has involved writing HTML, the language 

used to describe the design of a Web page and transfer it across the 

Internet to the computer used to browse the site. Even in Web design 

programs that offer WYSIWYG (What You See Is What You Get) layout, 

you still often need to be aware of the HTML being generated and take it 

into account when designing the components of your Web page. 

Freeway changes all this. It lets you focus on the design you want to 

achieve without the distraction of having to worry about how it will be 

encoded into HTML. As well as freeing you from the need to learn HTML, 

an incomprehensible and inconsistent language primarily designed to be 

easy for computers to understand, Freeway also provides the following 

outstanding benefits: 

Built-in site management

A finished Web site can typically end up as a series of folders containing 

numerous HTML files, graphic files, and other resources used in the site. 

Managing the names and locations of these files can be a nightmare, 

and simply renaming or moving a file can prevent the site from working 

correctly by breaking a link. Many programs provide site management 

utilities to keep track of the files in a site, updating the links when you 

make changes. 

In Freeway none of this is necessary. The entire design of your site is 

contained in a single document, which includes all the pages, text, and 

graphics used throughout the site. When you publish the site Freeway 

automatically generates the folder of HTML and graphic files with the 

correct links between them, so there is no possibility of incorrect links or 

invalid filenames. In other words, site management just isn’t an issue. 

Optimizing performance

Web sites not only need to look good; they also need to respond quickly 

to give users a positive experience of navigating through the information 

you provide. With many Web design packages you need to prepare your 

graphics using a separate application before importing them into your 

design, to optimize them for quick display. 

With Freeway this is no longer an issue. You can incorporate any type 

of graphic into your design, and scale or crop them in Freeway to 

achieve exactly the effect you want. When you publish the site Freeway 

automatically exports optimized versions of each graphic so your site is 

guaranteed to load fast and provide quick navigation. Beginners can work 

with Freeway safe in the knowledge that they won’t inadvertently create 

an inefficient site, and more experienced users will appreciate the time 

they save not having to prepare the graphics beforehand.

Intuitive interface

Freeway achieves all this using a highly intuitive user interface designed 

to reflect the way a graphic designer works. A page area represents the 

Web page you are designing, and you can simply drag and drop text and 

graphics onto the page, and position them where you want. 

A range of features makes it easy to lay out pages with precision, 

including rulers, guides, and grids, and you can define any number of 

master pages to make it easy to create a series of pages with related 

designs. 

Actions add advanced effects without coding

Many Web sites now include dynamic effects, such as rollover buttons or 

moving graphics, which go beyond the capabilities of standard HTML, and 

these generally involve adding special JavaScript routines to the page. 

Freeway allows you to add these effects to your site without any special 

coding, by taking advantage of Freeway’s built-in actions. Each action 
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allows you to specify which components of the page you want to control, 

and then automatically inserts the appropriate JavaScript code when you 

publish the site, with no programming required on your part. 

Applications
Freeway allows you to create a complete site of a few pages in a few 

hours. However, it is just as capable of creating large corporate sites, 

such as company Web sites or intranets, or commercial sites such as on-

line stores or shopping sites. 

This section gives a selection of sites created entirely using Freeway, to 

illustrate the range of applications that it is already being used for.

Personal Web sites

The personal Web site of David Dunnico, a photographer based in 

Manchester, UK:

Corporate Web sites

The corporate Web site of Blue Iceberg, a Web site development and 

marketing company:
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Commercial Web sites

The Web site of Fiesta Crafts, manufacturers of soft toys and gifts:

Online Web magazines

Colorado Woman News, an on-line Web magazine:

For more examples see the Gallery on the Softpress Web site at:

http://www.softpress.com/en/freeway/gallery



This chapter is aimed at users who have not created 

a Web site before, and discusses the issues 

involved in planning, creating, and hosting a site. 

If you have already created Web sites using other 

Web design packages you may like to skip to 

the next chapter, Quick tour, for an overview of 

Freeway’s unique features.
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Welcome to the World Wide Web

If you have surfed the Web but you have never actually set up your own 

Web site you may think that Web sites are a bit like radio stations, and 

using your Web browser to visit a Web site is like tuning your radio into a 

particular radio station. 

This analogy is pretty good apart from one major difference; the Web is 

totally democratic. You don’t need a license or an expensive transmitter 

to publish your site to the world; in fact all you need is a computer 

connected to the Internet and a centrally registered name, which costs a 

few dollars, so people know where to find you:

���
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How do I join?

To publish your Web site on the Web and make it available to other users 

you simply need to run a program called a Web server on your computer 

and give the computer a name registered with a central authority so that 

other users can find it on the Internet. 

Unless you have a permanent Internet connection, and don’t mind 

leaving your computer switched on all the time, you will probably find it 

more convenient to have your Web site hosted by a company specializing 

in this service, called an Internet Service Provider or ISP. 

If you already have an email account it probably has some free Web 

space included with it, and your ISP will provide instructions on how to 

upload your Web pages to your free Web space, and tell you what name 

users will need to use to connect to it. 

Speaking the right language
At the heart of the Web is a language called HTML which stands for 

HyperText Markup Language. HTML performs two basic functions: it 

describes what the page should look like, and it provides links to other 

pages.

For example, this is what the user sees:
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And this is the HTML to achieve it:

The page description part of HTML consists of a series of statements 

which say things like “Put this graphic at the top of the page”, “Put this 

text below it”. When the browser receives the HTML it reconstructs the 

page that the designer intended. 

The second part of HTML, called “hypertext links”, are what make the 

World Wide Web a Web rather than just a notice board. Each page can 

link to other pages within the same Web site, or to pages on other sites 

anywhere else on the Web. 

Just as you don’t need to understand the internal codes your word 

processor uses to store information about your document, you don’t 

need to know HTML to design Web pages.

What are HTTP and FTP?

These are two other acronyms that you might encounter, and it is just as 

well to know what they mean.

HTTP, or HyperText Transfer Protocol, is a set of conventions for 

transferring Web pages between a Web server and a Web browser. You 

are reminded of this every time you surf the Web by the http:// that 

your Web browser inserts in front of the address in the address bar. 

FTP, which stands for File Transfer Protocol, is a convention for 

transferring files over the Internet between two computers. FTP is the 

standard way of uploading files to a Web server, and is the method that 

Freeway uses to update your Web site remotely on your ISP’s Web space. 

Planning your Web site
Before embarking on the design of a Web site, decide what you want it to 

achieve, as this will influence your approach.

A Web site is just like any other type of media. It needs to have a 

clear target audience, and it needs to communicate effectively to that 

audience. 

If your Web site is purely designed to provide information, such as an 

educational site, then make sure it conveys that information clearly and 

simply. Good design can help to make the information easier to read. 

Poor design will undermine the authority of the site. 

If your Web site is a promotional site, to attract business to your services 

or company, make sure that it has a clear target market, and that it 

communicates effectively to that market. There is no point in designing a 

Web site that says “We just wanted to let you know that we exist”. Your 

site should inform potential customers about what you can do for them, 
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and then tell them what to do next: email you, telephone you, or order a 

product from you. 

Organizing the structure

Whatever type of site you are planning, make sure it will be easy to 

navigate through the site, and provide your users with an intuitive 

structure. 

Avoid the temptation to arrange the site like a computer hard disk, with 

a hierarchical structure of folders and sub-folders. This type of tree-

structured site can be confusing to users, or force them to revisit pages 

unnecessarily to access all areas of the site. 

Either make your site easy to navigate, by giving it a relatively flat 

structure with at most two or three levels in the hierarchy, or if you need 

a tree-structured site, give information about the user’s position in the 

tree with a list of the links they have visited at the top of each page, 

often called a breadcrumb trail.

Planning for change

A user may visit your site several times before they decide to contact 

you, use your business, or make a purchase. It is therefore in your 

interest to make your site worth revisiting, and you should plan that the 

information on it will be updated on a regular basis. 

If users see new information appearing on the site when they revisit, 

it will encourage them to return again at a later date. If the site hasn’t 

changed for several months visitors may wonder if you are still in 

business. 

If you haven’t got time to review the whole site on a regular basis, at 

least make sure you have one area that you update frequently, such as 

the home page.

Designing the layout

Just as with designing for print, you’ll probably want to take a few 

moments to rough out some ideas on paper before you sit down at 

the computer. Even experienced designers usually find that sitting at a 

computer staring at a blank page is the last place to find inspiration!

If you’re producing work for clients, the site may need to fit in with an 

existing identity, or you may be expected to come up with an identity 

yourself. Either way, you’ll want to get client approval for the design 

before you go too far in creating the site. Freeway is great for pulling 

a few ideas together quickly and producing two or three mock sites for 

clients to look at.

Preparing the content

With the design stage complete, you’re ready to begin creating and 

assembling the content for the site. This includes the basic text for the 

pages, and any graphic or multimedia elements that can’t be easily 

created within Freeway, such as photographs or animated GIFs.

It is recommended that you assemble all the resources before you 

import them into Freeway. When the project is complete, these original 

resources will be archived when you archive the whole site folder.

When creating bitmap images for the Web, it’s best to work at 72dpi. You 

don’t need to save your artwork as GIF or JPEG; Freeway can import TIFF, 

PDF, or native Photoshop images. However, in many cases you will be 

able to create artwork directly in Freeway.

If you’re creating illustrations you can import Illustrator files directly into 

Freeway, allowing you to scale or transform the vector artwork in Freeway 

without losing quality.
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Defining master pages

If you are creating a site of more than a few pages you will save time 

by setting up a consistent layout grid using one or more master pages. 

These master pages can then form the basis for the actual pages you 

create in your site. 

Master pages can be used to ensure consistent design, branding, 

and navigation throughout your site. When using links on graphics for 

navigation, duplicate the links using HTML text elsewhere on the page, 

so that visitors browsing with the images turned off, or using older 

browsers, can still navigate your site.

Previewing the site

Take care to preview the site using a variety of browsers, and on both 

Macintosh and PC computers. Unfortunately, because of browser 

inconsistencies, just because a page looks fine in one browser does not 

mean it will automatically look good in others.
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This chapter is designed to give you an overview 

of how Freeway works, with a guided tour of the 

program to introduce you to its key features.

Q
ui

ck
 t

ou
r



Q
uick tour

12

The Freeway site document
When you are working on a site in Freeway, a typical project folder 

contains the following four items:

Zoe’s Site is the Freeway document containing all the information 

about your site. Whether your site is a single Web page or hundreds of 

Web pages, all the information about it is stored in a single Freeway 

document. 

A .fwbackup file, which is a backup of your Freeway document in case 

the main file gets damaged, such as after a computer crash.

The Site Folder will contain all the HTML files and associated graphics 

when you publish the site.

The Media folder is the recommended location for any graphics, sound 

files, movies, or other resources that you want to include in your site.

Publishing a site
Creating a site in Freeway involves designing the pages in the site 

document, using a series of intuitive tools to allow you to position the 

text and graphics and add links between the pages. 

You can preview your pages as you work, using the Web browser built 

into Freeway:

You can also preview the site in any other Web browsers installed on 

your computer to allow you to compare how your pages will look to other 

users.

When your site is complete you can publish it to create a complete set 

of HTML files, graphics, and other materials needed to create the site. 

When you publish your site Freeway automatically generates all the 

correct HTML to achieve the appearance you designed, and optimizes 

all the graphics included in your site with the best compromise of quality 

versus download time. 

Graphics

A skillful use of graphics helps to create Web pages with visual impact. 

However, the downside is that heavily graphic based pages can take a 

long time to load in a Web browser. When incorporating graphics into a 

Web page it is therefore important to optimize their size to minimize the 

time they take to be displayed when a user loads the page. 
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Freeway liberates you from having to worry about how you incorporate 

graphics into your Web site. It allows you to work freely with graphics 

in almost any format, and at any resolution, and scale or crop them 

to achieve the effect you want. When you publish the site Freeway 

automatically generates new optimized graphics, taking into account any 

cropping, scaling, or other transformations performed to achieve the 

correct result when the visitor loads your page. 

HTML text

The most efficient way of representing text on a Web page is as 

HTML text, which is displayed using the fonts installed on the visitor’s 

computer. 

When designing a page with HTML text, Freeway automatically offers the 

set of fonts that are universally installed on most computers, such as 

Times, Helvetica, Verdana, etc. This ensures that the page will display 

correctly for any user, irrespective of which additional fonts they own. 

GIF text

In some cases you might want to include text in a non-standard font 

on your Web page. For example, you may want to include a logo in a 

corporate font, or include headings or subheadings in a font you have 

chosen to fit in with the overall design of the page. To achieve this 

you can render these sections of text as graphics so they will display 

correctly irrespective of the particular fonts your visitor has installed. 

Freeway makes it very easy to create sections of text as graphics, called 

GIF text. The text remains editable in your Freeway document, and you 

can apply styles, and even add visual effects, such as a drop shadow. It 

is automatically converted into a high-quality, smooth, anti-aliased graphic 

when you publish the site.

Links

You can create a link from a graphic, or section of text, simply by 

highlighting the object you want to link from and using the Hyperlink 

command. Freeway automatically manages the links within your site, and 

assigns appropriate names to them when you publish the site. You do 

not need to be concerned about keeping links up to date, and there is 

never a possibility of creating a broken link in your final site.

Other resources

In addition to the text and graphics managed by Freeway in your site 

document you can also incorporate external resources, such as movies, 

sound files, PDF documents, and links to other sites.



Q
uick tour

14

Working with Freeway
This section will give you a guided tour of the Freeway window and 

explain what each of its features do, including the tools on the toolbar, 

the Inspector palette, and each of the other palettes.

The following diagram shows the key components of the Freeway 

interface:

���������������
�������

��������

�������

����������

������������ ���������

�����������������

���������

���������

�������������

Each of these features are described in greater detail in the following 

sections.
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The Freeway window
The Zoom menu shows the scale of the current page, and allows you to 

change it.

The Hyperlink box allows you to make selected graphics or text into a 

hyperlink simply by dropping a page icon from the Site panel. Clicking 

the Hyperlink box with an appropriate item selected displays the Edit 

Hyperlink dialog box.

The Page mode buttons let you change the information displayed in the 

Page area.

Tools
The tools allow you to create or manipulate the different types of item 

you work with in Freeway. The following table describes the function of 

each tool:

Standard tools

Tool Description What it does

Back/Forward Steps between recently visited 

pages.

Select tool Selects or manipulates items or 

edits text.

Zoom tool Zooms in and out of the Freeway 

window to change the scale of 

what you are working on.

Tool Description What it does

CSS Layout Specifies whether new items 

added to the page use CSS layers 

or invisible tables (compatible with 

older browsers).

HTML Draws an HTML item on your page, 

to enter HTML text in your site.

Table Draws a table on your page, with 

a specified number of rows and 

columns.

Action Adds a Freeway action to the page. 

Graphic Draws a rectangular graphic item 

on your page, to add a graphic 

image or GIF text.

Oval Draws a graphic item with an oval 

outline.

Map Area Draws rectangular clickable areas 

on images.

Rotate Rotates graphic items.

Flow tool Links two or more HTML or graphic 

items together so that text can 

flow between them.

Inspector Displays or hides the Inspector 

palette.
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Optional tools

These are available from submenus on the standard tools, or you can 

add them to the toolbar using the Customize Toolbar… option on the 

View menu.

Tool Description What it does

Separator Adds a dividing line to the toolbar.

Space Adds a space to the toolbar.

Flexible Space Adds a space that right-aligns 

subsequent icons in the toolbar.

Customize Displays the Customize Toolbar 

dialog box.

Break Flow Unlinks HTML or graphic items that 

have been linked with the Flow 

tool.

Path Draws a graphic item with an 

arbitrary outline constructed from 

straight lines or smooth curves.

Button Adds a button to a form.

Checkbox Adds a checkbox to a form.

Tool Description What it does

Radio Adds a radio button to a form.

Text Field Adds a text field to a form.

Menu/List Adds a pop-up menu or list item to 

a form.

Text Area Adds a text area to a form.

Oval Map Area Creates an oval clickable area on 

an image.

Path Map Area Creates a clickable area with an 

arbitrary outline on an image.

Skew Skews graphic items.

Mirror Mirrors graphic items.

Styles and 

Colors

Displays or hides the Styles and 

Colors palette.
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Panels
Link Map

The Link Map provides an easy way to view the structure of your site, 

and lets you click on pages to show the links to and from that page:

Site panel

The Site panel shows the master pages available to your site, and shows 

the structure of the HTML files in your site folder:

You can use the Site buttons below the Site panel to restructure your 

site, add or delete pages or masters, add folders, or rename pages.
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Page panel

Clicking the Site panel title bar toggles between the Site panel and the 

Page panel. The Page panel shows the structure of graphic files and 

other resources on the current page. Selecting a specific item selects it 

on the page to allow you to edit it.

Palettes
Inspector palette

The Inspector palette provides information about the currently selected 

object on your page, and allows you to change its settings. 

For example, if you have selected a graphic item the inspector palette 

allows you to change its dimensions, add graphic effects, or specify the 

output format. 

Alternatively if you have selected text the Inspector palette allows you to 

specify the character and paragraph settings, change the text color, and 

add text effects.

The Inspector palette usually provides several pages of settings, which 

you can select by clicking the appropriate icon at the top of the palette. 

The following table summarizes the most important pages of settings 

provided for different types of objects:

Icon Name Description

General settings The name of the item, its 

dimensions, and its position on 

the page.

Appearance 

settings

Settings affecting the appearance 

of the item, including color and 

effects.

Character and 

pararaph settings

The character and paragraph 

settings for text.
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Icon Name Description

Table cell settings The size and alignment of a cell in 

a table.

Output settings Settings relating to the HTML 

generated for the item when the 

site is published.

On some pages of the Inspector palette the settings are divided into 

sections which you can show or hide by clicking the > to the left of the 

section heading. 

For example, for a graphic item the appearance panel of the Inspector 

palette divides the settings into Shape Effect, Shadow, Glow, 

Background, Foreground, and Border sections:

Styles and Colors palette

The Styles and Colors palette lets you define or select text styles, to 

specify the appearance of HTML and graphic text, and to define or select 

colors for use on your pages:
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Actions palette

Actions can be added to pages, or items on the pages, to create dynamic 

effects, such as rollover buttons or pop-up windows. The Actions palette 

allows you to view or edit the settings associated with each action:

Frames palette

The Frames palette allows you to create and edit frame-based pages, 

with separate scrolling areas of content on a single page:

Contextual menus
In most situations holding down c and clicking a window or an object 

displays a pop-up contextual menu of useful commands appropriate to 

that window or object.

For example, holding down c and clicking a graphic in a graphic item 

provides commands for editing, transforming, linking, arranging, or 

duplicating the graphic:



This is the first of three tutorials designed to 

introduce you to the key features of Freeway, and to 

demonstrate how easy it is to create an impressive 

Web site in a few simple steps.

In this tutorial you will create a site with one page, 

designed as the home page for the graphic artist 

Zoe Marx, to serve as a showcase for her work.
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Starting the site
Run Freeway

• Double-click the Freeway icon:

This will normally be in your Applications folder.

The New Document dialog box will be displayed:

Freeway is supplied with several sets of templates which you can preview 

in the New Document window and select as the starting point for your 

site.

• Select Blank in the General section to start with a blank document, 

and click the OK button to continue.

You will be prompted to give the new site a name.

• Enter Zoe’s Site and click the Save button to continue:

A blank Freeway document window will be opened for you, titled 

Zoe's Site, and a Zoe's Site folder will be created for the site in your 

Documents folder:

The site folder contains the following items: 

Zoe's Site, the Freeway document containing all the pages in your site, 

including any text and graphics they contain.

Site Folder, used by Freeway as the location of the HTML files and 

graphics when you publish your site. You should not normally change the 

contents of this folder.

Media, which is provided as a recommended place to store graphics and 

any other resources used in your site.
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When you first create a new site the Freeway window shows a blank 

untitled page.

The following diagram explains the key features of the Freeway window:

Displays the 
Inspector palette.

Shows information 
about the currently 
selected item and 
allows you to edit it.

Shows the text 
styles and colors 
used in your site 
and allows you to 
edit them.

Allows you to edit the 
master page, see a map 

of your site, edit the 
current page, or preview 

the current page.

Menu bar

The tools you use 
to design pages.

Master pages

Shows the 
structure of the 

files in your site.

This is where you 
design your Web 
pages.
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Give the home page a title

When no item is selected on a page the Inspector palette shows the 

general page settings.

•Change the Title from Untitled to Zoe Marx – Designer:

This will be the title displayed when the page is viewed in a Web browser, 

or listed in search engines such as Google.

• Change the File name to index.html unless your ISP tells you to use a 

different name for the home page. 

This will be the page displayed if someone connects to the site address.

Add a background image

Pages can include a background image, which can be used to provide a 

texture or pattern behind everything else on the page.

For the background of Zoe’s home page we are going to use a scan of 

some textured paper to represent the art paper that designers often use 

for freehand illustrations.

• Copy the files from the following location: 

Freeway 4 Pro/Documentation/Getting Started with Freeway/Tutorial 1 

Files

• Put them in the Media folder in your Zoe's Site folder.

• Click the paintbrush icon at the top of the Inspector palette to display 

the appearance settings for the page.

• Choose Select from the Image pop-up menu and select the file paper.

jpg in the Media folder:

• Click the Open button to load it. 
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The image will be displayed as the background for the page:

The image is automatically repeated, or tiled, both horizontally and 

vertically to fill the user’s browser.

Designing a logo
The next step is to design a headline for the site, using the text and 

graphics features built into Freeway. 

Create graphic text

For the main logo we want to use a particular script font available on our 

computer. Because our logo is going to create an identity for the site it 

is important that it displays in the correct font, whether or not the visitor 

has the appropriate font installed on their computer. 

We are therefore going to render the logo as a graphic, so it will display 

correctly whatever particular set of fonts the user has installed. An 

additional advantage of creating the logo as a graphic is that we can 

use graphic effects and transformations, as these are not available with 

HTML text.

The first step is to create a graphic item to contain the logo.

• Click the Graphic tool in the toolbar:

• Drag to draw a rectangle at the top of the page.

When you let go of the mouse pointer the Select tool will automatically 

be selected:

• Double-click anywhere in the graphic item with the Select tool and type 

the text:

Zoe Marx Designer
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• Select the text you have just typed in:

You can then edit its font, style, size, and other characteristics in the 

Inspector palette.

• Click the text icon at the top of the Inspector palette to display the 

character and paragraph settings.

• Set the font to Zapfino, the Size to 38px, and the Leading to 50%:

If the text does not fit in the box, an overflow icon will be displayed in the 

bottom right corner.

• Select the box, then drag one of the corners until the text fits.

Note that because the font we have chosen has long descenders (tails), 

the characters can actually extend outside the graphic item:

Freeway will automatically take this into account when we publish the 

site, making sure the graphic is created large enough to include all of the 

characters.



Tu
to

ri
al

 1
 C

re
at

in
g 

a 
ho

m
e 

pa
ge

27

Change the text color

• Select the text again.

• Click the paintbrush icon at the top of the Inspector palette to display 

the text appearance settings.

• Choose Other… from the Color pop-up menu:

The Color dialog box allows you to change the text color.

• Select the last color on the fourth row, a rich brown color, and click the 

OK button to apply it to the text:

Rotate the text

• Select the Rotate tool:

• Click the graphic item to select it.

• Drag the graphic item by one corner to rotate it:

Apply a drop shadow

The next step is to apply a subtle drop shadow to the text using 

Freeway’s built-in text effects. This illustrates how you can achieve 

sophisticated graphical text effects within Freeway without having to first 

prepare your graphics in a separate program. 

• Select the text again.

• Click the paintbrush icon at the top of the Inspector palette to display 

the text appearance settings. 
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• Click the arrow to the left of the Shadow heading to display the 

Shadow settings.

• Click the Shadow checkbox to add a drop shadow, and set the Offset 

to 8%:

You can leave the other settings at their default values.

A subtle drop shadow will be added to the text.

Adding an introduction
The next step is to add a paragraph of text explaining the purpose of the 

site, and introducing the other components of the page. For this text we 

will use an HTML item, with the text displayed in one of the standard 

Web fonts installed with most browsers. 

Create HTML text

HTML text is preferable for the body text on a Web page because it loads 

quickly and is indexed by search engines so users will find the site if they 

search for words in the text.

• Click the HTML tool in the toolbar:

• Draw a rectangle to the right of the graphic box to contain the 

introductory text.

When you release the mouse pointer the Select tool will be selected:

• Click anywhere in the HTML item and type the following text:

Zoe Marx is a young, innovative graphic designer 

specializing in freehand illustration and calligraphy.

This site gives examples of some of her recent work 

for a range of clients.

• Drag to select all the text, or open the Edit menu and choose Select 

All.
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• Click the text icon at the top of the Inspector palette to display the 

character and paragraph settings for the text.

• In the Character section set the Font to Georgia and the Size to 14px.

• In the Paragraph section click the center align paragraph button: 

The text will be formatted with the settings you specified:

Preview the results

To see what the page will look like in a Web browser you can preview your 

page at any stage.

• Click the Preview button in the bottom right corner of the Freeway 

window to display a preview of the current page.

This shows the page as the user will see it in a typical Web browser such 

as Safari.

• Click the Page button in the bottom right corner of the Freeway window 

to return to Page view.
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Adding graphics to the page
The next step is to import three graphics showing examples of Zoe’s 

work onto the page. Freeway allows you to crop, resize, and transform 

graphics without worrying about their size or quality. When you publish 

the site they are optimized for best possible quality and fast Web display.

Import graphics

• Drag each of the files pic1.gif, pic2.gif, and pic3.gif from the Media 

folder and drop them onto the background of your Web page.

A graphic item will automatically be created for each image.

Then scale each of the images so they fit nicely together on the page as 

follows:

• Select an image by clicking it with the Select tool.

• Drag the image by one of its handles while holding down S and 

O to scale the image keeping its proportions correct:

• Use the Bring to Front, Send to Back, Bring Forward, or Send 

Backward commands on the Item menu to change the way the 

pictures overlap.
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Add contact information

We will now add contact information at the bottom of the page, so 

visitors know how to contact the site:

• Draw an HTML item the full width of the page and enter the contact 

information text:

Contact Zoe Marx for more information about her 

design services: zoe@freeway4.com 

• Use the Inspector palette to set this text to Georgia, 14px, centred as 

before.

Finally we will make the email address into a link so that users can 

simply click it to open a new blank email with the correct address.

• Highlight the email address:

• Open the Edit menu and choose Hyperlink… to display the Edit 

Hyperlink dialog box.

• Click External to define an external hyperlink.

• Choose mailto: from the Protocol menu.
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• In the text box type zoe@freeway4.com after the mailto: prompt:

• Click the OK button to define the link.

• Finally, preview the site as before to see the result:
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Uploading the site via FTP
When your site is complete the final step is to upload it to the Web space 

provided to you by your Internet Service Provider, so it is accessible to 

other users on the Internet.

Upload the site

• Open the File menu and choose Upload… to display the Upload dialog 

box.

This example assumes you will be uploading by FTP, the usual method.

• Choose FTP from the Upload pop-up menu.

• Enter the following information in each of the fields:

Field Description

Server The address of your ISP’s FTP server. For example: 

ftp.internetcompany.com.

Directory The directory given to you by your ISP; this will often 

be your user name.

User name The user name of your account.

Password The password of your account.

The files will be uploaded to the FTP space and Freeway will confirm 

whether the upload was successful.

Connect to the site

Assuming you know the correct URL for your Web space, which should 

have been given to you by your ISP, you can now connect to your site and 

check your site in the browser.

Note that if you make changes to your site and upload the site a second 

time Freeway will determine which files have changed, and only upload 

the changed files as required to update the site on the server.

Uploading the site to a .Mac account
If you do not already have an account with an Internet Service Provider 

you may like to consider starting a .mac account. It’s easy to do, and 

there is a free 60 day trial. 

Set up a .Mac account

• Click the .Mac icon in the Internet & Network section of your Mac’s 

System Preferences dialog box:

• In the .Mac dialog box click the Sign Up button.

• Complete the .Mac entry form as instructed and click the Continue 

button to register an account.

Upload the site

When you have registered your .Mac account, upload your site as follows:

• Open the File menu and choose Upload….
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• In the Upload dialog box choose .Mac from the Upload pop-up menu.

• Enter your Member name and Password:

• Click the OK button to upload the files. 

The site will be uploaded to your .Mac idisc space:

Connect to the site

You can then connect to the Web site using the address:

homepage.mac.com/yourname/

Where yourname is the user name you chose when you registered.

Note that you could also have copied your site across to the .Mac Web 

space simply by dragging the contents of the Site folder to the idisc Sites 

folder. However, it is more convenient to use Freeway’s Upload option 

because this automatically checks which files have changed and only 

uploads the necessary files. 

What next?
Congratulations! You have now created your first Web site in Freeway. 

This tutorial has shown how to set up a new site, incorporate graphics 

and text, edit the layout of the site, and publish the site to your Web 

server.

The next tutorial shows how to create a more complex site with multiple 

pages, and links to enable users to navigate between the pages. It also 

shows how Freeway’s master pages make it easy to create sites with a 

consistent style across several related pages.



This second tutorial describes how to create a larger 

site with several pages, using tabs to allow users to 

navigate between pages. You will also learn how to 

use the master page to impose a consistent style 

on the site and make it easier to link the pages 

together. 

For this tutorial we will create a site designed to 

give information about chilli peppers. It will include 

a home page, a recipes page, and an information 

page describing the different varieties of chillies. A 
m
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Designing the navigation bar
To make it easy to navigate between pages our Chilli Pepper site is going 

to provide a series of tabs along the top of each page, designed to look 

like filing-card tabs. The current page is indicated by the frontmost tab, 

and you can click on any of the tabs to bring another page to the front. 

Create a master page

Freeway allows you to create one or more master pages, containing 

design elements that you want to include on related pages in the site.

You can then use the master page as the starting point for each of the 

site pages you create.

• In the New Document dialog box select the Blank template and click 

the OK button.

• In the Save dialog box enter the name Chilli Pepper Site and 

click the Save button.

• Copy the files from the following location: 

Freeway 4 Pro/Documentation/Getting Started with Freeway/Tutorial 2 

Files

• Put them in the Media folder in the Chilli Pepper Site folder.

• Click the Master button in the bottom right corner of the Freeway 

window to display the default master page for the site:

On the master page we will show all of the tabs in their back position. 

Then on each page we will change the appropriate tab to its front 

appearance.

Define a grid

The first step is to define a grid to help position items accurately on each 

page.

• Open the Page menu and choose Grids….

The Grids dialog box is displayed.

• Choose Document from the Apply to pop-up menu to apply the grid to 

every page in the site.

• Select Vertical and Horizontal to define a vertical and horizontal grid, 

and set the Width and Height fields to 32px to specify the spacing of 

the grid.

• Set the Left field to 20px to inset the grid 20px from the left:

• Click the OK button to use the grid you have specified.
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Draw the navigation bar

We are going to use the drawing features built into Freeway to draw the 

tabs used for the navigation bar. First we will draw the bar from which the 

tabs extend.

• Click the Graphic icon in the toolbar:

• Drag to draw a graphic item the full width of the page.

• Click the general settings icon at the top of the Inspector palette to 

show the item general settings.

This icon changes to reflect the currently selected item.

• In the Dimensions section edit the Height field to set the height to 

20px:

• Click the paintbrush icon at the top of the Inspector palette to show 

the item appearance settings.

• Select Background and choose red from the Color pop-up menu to the 

right of the Background heading:

• Drag the bar so it snaps to the first horizontal gridline:

Design the navigation tab

Next we are going to define the graphic for each tab in its unselected 

state.

• Draw another rectangular graphic item.

• Click the general settings icon at the top of the Inspector palette to 

show the item general settings.
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• If necessary, click the > to the left of the Dimensions heading to show 

the Dimensions section, and edit the size to 128px by 52px:

• Click the > to the left of the Other heading to show the Other section.

• Edit the Corner field to 12px to give the tab rounded corners:

• Click the paintbrush icon at the top of the Inspector palette to display 

the item appearance settings.

• Click the > to the left of the Border heading to display the Border 

settings. 

• Check the Border checkbox to add a black border, and choose Inside 

from the Position pop-up menu to draw it inside the box:

We have now defined the plain tab with a border:

Add a graduated fill

Next we will use one of the graphic actions to add a graduated fill to the 

graphic item. With the graphic item still selected:

• Open the Item menu, choose Actions, then choose Fill Master from 

the submenu.

This adds the Fill Master action to the graphic item.

• Open the Window menu and choose Actions to display the Actions 

palette.

This allows you to edit the action’s parameters.
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• Choose Linear from the Fill pop-up menu to define a linear graduated 

fill.

• Choose White from the First pop-up menu and Black from the Second 

pop-up menu, and edit the angle to -90, to create a graduated fill that 

goes from white to black vertically.

• Set the Opacity to 25%:

The item is filled with a graduated fill that goes from white to 25% grey:

Add a label to the tab

The next step is to add a label to the tab to identify it on the navigation 

bar.

• Double-click in the graphic item to position the insertion point at the 

top left corner and type About.

• Select the text, then use the options in the Character section of the 

Inspector palette to set the text to Verdana 12px.

• Click the center align icon in the Paragraph section:

• Add a R at the start of the text to position it on the second line of 

the button.

The button will be displayed with a centered label:
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• Drag the button to its correct position at the top of the page and 20px 

from the left:

You can use the Dimensions section of the Inspector palette to see the 

item’s position as you drag it.

Create the remaining tabs

• Select the button, then open the Item menu and choose Duplicate….

• In the Duplicate dialog box set the number of copies to 3 and the 

Horizontal offset to 128px:

• Click the OK button to create the copies.

• Edit the label on each of the copies to Recipes, Growing 

Chillies, and Where to Buy.

• Finally select the bar graphic, then open the Item menu and choose 

Bring to Front to put the bar in front of the four tab graphics:

Creating the other pages of the site
The next step is to create the three additional blank pages for use in the 

site, and then link the tabs on the master page to the blank pages we 

have created.

Create the site pages

• Open the Page menu and choose New pages….

The New Pages dialog box is displayed.

• Type 3 into the Pages field and click the OK button:
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Three new pages named Untitled1, Untitled2, and Untitled3 will be 

created.

• In the Site palette click the first page, Untitled, while holding down 

O, and edit its name to About:

• Likewise, edit the names of the other pages to Recipes, Growing 

Chillies, and Where to Buy.

Link the tabs to each page

The next step is to link from each tab on the master page to the 

appropriate page in the site. Creating these links on the master page will 

avoid the need to do them on each of the site pages.

• Click the Master1 icon in the Site palette to display the master page 

again.

• Click the About tab to select it.

• Drag the About page icon from the Site palette and drop it onto the 

Hyperlink box below the page area:

A link item will be displayed on the graphic to indicate that it is linked 

to another page, and the name of the page it links to, About, will be 

displayed in the Hyperlink box at the bottom of the screen: 

• Link the other three tabs to the remaining three pages in a similar way.
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Create the tabs on the content pages

The next step is to create the correct tabs on each of the content pages. 

• Click the About tab on the master page.

• Open the Edit menu and choose Follow Link….

The page linked to by the tab, called About, will be displayed.

• Select the About tab, click the icon to the left of the Hyperlink box and 

choose None from the pop-up menu, since we do not want this tab to 

link anywhere (as we are already there). 

• In the Actions palette, set the parameters for the Fill Master action to 

100% opacity and choose Red from the Second pop-up menu:

The tab on the About page now has a red graduated fill:

• Click the second tab, then open the Edit menu and choose Follow 

Link… to jump to the second page.

• Repeat the previous steps to set the tabs on the Recipes, Growing 

Chillies, and Where to Buy pages.

Preview the site

You can now preview the site and verify that you can navigate between 

pages by clicking the appropriate tab.

• Open the File menu and choose Preview in Browser, then choose the 

browser you want to use from the submenu.
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Creating the About page
The next step is to design the About page for the Chilli Pepper Web site; 

this will introduce the site.

Create the heading

• Click the About icon in the Site panel to display the About page.

• Draw a graphic item just below the navigation bar, and the full width of 

the page.

• Type in the text: 

Welcome to the Hot Chilli Pepper Site!

• Select the text and use the Inspector palette to convert it to Sand, 

24px, Red, centered:

Add the content

• Drag the graphic chillies.jpg from your Media folder and drop it in the 

center of the page.

• Click the HTML icon in the toolbar:

• Draw two HTML items, one each side of the picture.

• Click in the left-hand HTML item, open the File menu and choose 

Import Text…, then select the file text1.txt in the Tutorial folder.

• Likewise, import the text text2.txt into the right-hand HTML item.

• Select the text in each HTML item and set it to Verdana, 14px.

• Select each heading and change the style to bold.

• Position the items to create a neat layout:
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Creating the Recipes page
The next step is to create the Recipes page which will provide a list of 

chilli recipes.

Create the heading

First create the heading:

• Select the heading graphic item on the About page, open the Edit 

menu, and choose Copy.

• Go to the Recipes page, open the Edit menu, and choose Paste.

The graphic item will be pasted in the corresponding position on the new 

page.

• Select the text of the heading and type over it: Recipes.

Add the recipes

• Click the HTML icon in the toolbar and draw a rectangle in the centre 

of the page. 

• Drag it by the handles on each of the edges and expand it to fill the 

page:

• Click in the HTML item with the Select tool, then open the File menu 

and choose Import Text…. 

• Select the file recipes.txt and click the Open button to import it. 

The HTML item and page will expand to accommodate all the text.

This text contains four recipes. We are going to use styles to format the 

recipes in a consistent way.
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Define a style for the recipe names

First we will define a style for the recipe titles.

• Select the text Chilli Corn Chowder on the first line of the text.

• In the Inspector palette set the Font to Verdana, the Style to bold, 

and the Size to 14px:

We will now define this style with the name Recipename.

• If necessary, open the Window menu and choose Styles to display the 

Styles and Colors palette.

Every style you create in your site is automatically given a temporary 

name in the Styles and Colors palette, such as style5. In addition, you 

can create permanent styles that remain permanently available; these 

are shown in bold.

• Click the text icon at the top of the Styles and Colors palette to 

display the document styles.

The temporary style created for the text you just formatted is highlighted 

in the Styles list.

• Click the style while holding down c and choose Edit Style… from 

the pop-up menu:

• In the Name box enter the name Recipename to name the style, and 

select Permanent:

• Click the OK button to save the style. 
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Apply the new style

Having defined a style you can now apply it to any text in your document 

simply by selecting it in the Styles palette.

• Select the heading for the second recipe, Guacamole.

• Click Recipename in the Styles palette.

The style will be changed to the new style you have defined.

• Repeat this for the remaining two recipes, Mexican Tabouleh and 

Salsa Verde.

Define styles for the recipe descriptions

Now define two further styles for the content of each recipe:

• Select the description for the first recipe and use the Inspector palette 

to change it to Verdana, 12px. 

• Click the style while holding down c, choose Edit Style… from the 

pop-up menu, select Permanent, and name this Instructions. 

Define styles for the ingredients

Finally we will create a style using paragraph formatting to add a bullet in 

front of each ingredient.

• Click the options icon at top right corner of the Styles and Colors 

palette and choose New Style… from the pop-up menu. 

• Choose CSS Attributes from the View pop-up menu to show only the 

attributes for HTML text.

• Enter the name Ingredients.

• Click the + at the right of the Character section and choose Font from 

the pop-up menu.

• Choose Verdana from the Font pop-up menu.

• Likewise, add Size to the Character section and set the Size to 12px.

• Finally, add List to the Paragraph section, and choose Round Bullets 

from the List pop-up menu:

• Click the OK button to create the new style.

• Select the ingredients for the first recipe and click Ingredients in the 

Styles palette to apply the style to the text:
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The first recipe has now been formatted correctly:

• Format the remaining recipes in a similar way using the styles you 

have created.

Creating the Growing Chillies page
Finally, the Growing Chillies page is going to present information about 

several varieties of chillies, how hot they are, and how easy it is to grow 

them. For this page we will use a table and import tab-delimited text into 

the table.

Create the heading

• Select the graphic item containing the Recipes heading, then open the 

Edit menu and choose Copy.

• Click the Growing Chillies page icon in the Site palette.

• Open the Edit menu and choose Paste.

• Edit the heading text to Growing Chillies.

Import text into a table

• Click the Table icon in the toolbar:

• Draw a small table on the page.

The Insert Table dialog box will be displayed:

• Leave the default settings and click the OK button to create a 2 x 2 

table. 
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• Double-click to insert the text insertion point in the top left cell:

• Open the File menu and choose Import Text….

• Select the file Chillies.tab in the Media folder, and choose Tab 

Delimited from the Import pop-up menu:

• Click the Open button to import the text. 

The following dialog box will be displayed warning you that the table is 

not large enough to import the text:

• Click the OK button to automatically enlarge the table to the correct 

numbers of rows and columns for the text.
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Now use one of the styles defined earlier to change the style of the text 

in the table:

• Click the border of the table to select the entire table.

• On the Styles palette click Instructions to set the text in the table into 

the Instructions style you defined earlier.

Resize the table

The next step is to resize the table to fit the text neatly.

• Drag the right-hand edge of the table until it is almost the full width of 

the page.

Now resize the first and second columns of the table so the text just fits 

onto one line as follows:

• Drag anywhere on the vertical divider between the two columns, 

holding down C before you release the mouse button to keep the 

total size of the table fixed. 

• Drag the horizontal dividers between the rows to remove any extra 

space in each row.

The Growing Chillies page is now finished:

What next?
This completes the second tutorial, in which you have created a multi-

page Web site, taking advantage of the master pages to give each page a 

consistent design.

The final tutorial shows how to add dynamic effects to your site using 

Freeway’s built-in actions.
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This final tutorial will demonstrate how easy it is to 

create Web sites containing impressive dynamic 

effects using Freeway’s built-in actions. 

The tutorial is based on a site designed as a 

showcase for a photographer’s work, and dynamic 

effects are used to present the photographer’s 

images in a striking way. 
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Introduction
Freeway’s actions allow you to add dynamic effects to your Web site, 

effects that cannot be achieved with standard HTML. This section gives 

some examples of the types of things you can achieve with actions.

Rollover buttons

Rollover buttons change appearance when the user moves their mouse 

pointer over the button, or clicks the button. For example, you could 

make a button light up when the user moves their mouse pointer over it.

Slave images

You can combine rollover buttons with slave images so that when the 

user clicks or moves the mouse pointer over a rollover button, an image 

called a slave image appears elsewhere on the page. For example, you 

could use this to display an image when the user points to different 

locations on a map.

Pop-up windows

A third set of actions allow you to display a separate page in your site 

as a pop-up window over the current page. This is useful for displaying 

information that is subsidiary to the current page, such as help text, or a 

larger version of an image on the page. 

Pop-up windows are normally displayed without an address bar or tool 

bar, to reduce their size, and they can either remain permanently on the 

screen, or can be defined to close automatically after a specified delay.

How actions work

Each action prompts you to specify the information it needs in a series 

of panels in the Actions palette. The individual parameters depend on 

the particular action you are defining, but in most cases they specify 

when the action should be triggered, for example by the mouse moving 

over a graphic, and what the effect of the action should be, for example 

displaying a slave image.

You can create several independent actions on a single page by defining 

slave groups. This ensures that the items involved in one action will not 

interact with the items involved in the other actions. Each slave group is 

identified with a unique name, such as Indigo.

Creating a logo for the site
The first step is to create an impressive logo for the site. To do this we 

will use a special feature of Freeway, knockout text. 

Import an image as the text fill

• Run Freeway and create a new blank site based on the Blank 

template.

• Save the site and name it Photographer.

• Copy the files from the following location: 

Freeway 4 Pro/Documentation/Getting Started with Freeway/Tutorial 3 

Files

• Put them in the Media folder in the Photographer folder. 

• Drag the image cloud.jpg from the Media folder onto the blank page. 

• Drag the image into the top left corner of the page.

• Drag the bottom right corner of the image while holding down S 

O to scale the image to the width of the page.
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• In the Inspector palette change the height of the graphic item to 

172px:

• Drag the image within its box using the panning handle at the center of 

the image until the cloud is positioned as shown below:

Create the knockout text

Now create a second graphic item to contain the name of the site.

• Click the Graphic tool in the toolbar and draw a graphic item below the 

cloud image.

• In the Inspector palette change its size to the same size as the cloud 

image, 550px x 172px:

• Click the paintbrush icon at the top of the Inspector palette to show 

the item appearance settings.

• Select the Background checkbox to set a default white fill:
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• Click in the graphic item and type the text: 

Philip Smith Photographer

• Select the text, then click the text icon at the top of the Inspector 

palette to display the character and paragraph settings.

• Set the Font to Impact, the Color to Knockout, the Size to 80px, and 

click the Align center icon:

The font Impact is a bold font ideal for cutting out the image below it. 

• Drag the graphic item containing the text onto the graphic item 

containing the cloud image until it is exactly on top. 

When you release the mouse pointer the graphic will be redrawn with the 

text knocking out the image below it:

Creating rollover buttons
The next step is to create four rollover buttons which will change 

appearance when the user moves the mouse pointer over them. 

Draw a 3D button

To create the buttons we will use the built-in Freeway Buttons action. 

• Click the Graphic icon in the toolbar and drag to draw a rectangle for 

the first button.

• Open the Item menu, choose Actions, then choose Buttons from the 

submenu.

• If necessary, open the Window menu and choose Actions to display 

the Actions palette showing the parameters for the buttons. 
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• Choose Black from the Color pop-up menu and select Shadow:

• In the Inspector palette name the item Button1Off and change the 

size of the button graphic item to 160px by 64px:

The button will be displayed on the page:

Add a caption to the button

• Double-click in the graphic item to insert the insertion point and type 

in the text:

Queens College

• Select the text.

• In the Inspector palette set the Font to Impact, the Color to White, 

the Size to 18px, and click the Align center icon:

Finally, position the caption vertically as follows:

• Click in the text, open the Style menu and choose Shift, then choose 

Other… from the submenu.
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• Set the baseline shift to -100%:

• Click the OK button.

The caption will be centered vertically over the button:

Create the rollover effect

The next step is to use the Rollover action to make the button light up 

in anticipation of being clicked when the user moves their mouse pointer 

over it. To achieve this we will change the color of the button to blue.

• Select the button graphic item, then open the Item menu and choose 

Duplicate….

• In the Duplicate dialog box leave the offsets set to 0px and click the 

OK button:

This makes a copy of the button superimposed over the original to create 

a stack of images.

• In the Inspector palette name this version of the button Button1On.

• In the Actions palette change the Color for the Button1On button to 

Blue.

• Drag to draw a selection rectangle around the stack of images, so that 

they are all selected:

• Open the Item menu and choose Actions, then choose Rollover from 

the submenu. 

An additional Rollover tab will appear in the Actions palette.

• Click the Rollover tab to display the rollover parameters.

The Rollover panel has two sections that you can switch between by 

clicking the two buttons at the top of the panel. 

Initially the Images section is displayed. Checkmarks show whether 

each image is visible in the Normal and MouseOver states. Initially both 

images are visible only in the Normal state.
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• Click to remove the checkmark against Button1On in the Normal 

column, and click to add a checkmark against Button1On in the 

MouseOver column:

You can click the heading of each column to preview the corresponding 

state of the images.

• Click the Parameters button.

• Change Click # to 1 to make this button trigger slave action 1. We will 

use this later:

The other options can be left at their defaults.

• Repeat to create two more buttons labelled Bridge of Sighs, with Click 

# set to 2, and Bodlean Library, with Click # set to 3:

Align the buttons

• Drag to draw a selection rectangle around all three buttons.

• Open the Item menu and choose Align…,

• In the Alignment dialog box click the Vertical center align items icon:

• Click the OK button to align the buttons.

• Preview the result by clicking the Preview button at the bottom right of 

the Freeway window.
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• Click the Page button to switch back to the Page view.

Adding the slave images
The next step is to add the slave images that will be displayed when 

each of the buttons is clicked. 

Import the images

• Click the Graphic icon in the toolbar.

• Draw a large rectangular graphic item below the buttons, the full width 

of the page.

• Open the Item menu and choose Duplicate…. 

• Set the Number of copies to 2 and the offsets to 100px:

• Click the OK button to create a stack of 3 graphic items.

• Drag the image college.jpg from the Media folder and drop it onto the 

first graphic item.

• Click the graphic item to select it.

• Open the Item menu and choose Graphic, then click Scale and Pad on 

the submenu.

This scales the graphic, keeping its aspect ratio proportional, and 

padding the graphic item on the side if necessary.

• Drag the sighs.jpg image and drop it onto the second graphic item, 

and scale and pad this in the same way.

• Repeat for the bodlean.jpg image in the third graphic item.

• Drag to select all three images and use the Align command to align 

them so they overlap exactly.

You now have a stack of images on the page.

• With the images still selected open the Item menu, choose Actions, 

then choose Slave Image from the submenu.

• On the Actions palette click the Images button, uncheck the 

checkmarks in the Normal column, and set checkmarks to assign the 

images to the trigger numbers we defined for the rollover buttons:
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• Now use Preview mode to preview the final site: What next?
Congratulations! You have just completed the third tutorial, using 

Freeway’s actions to add dynamic effects to a site.

Refer to the Using Freeway guide for detailed information about working 

with graphics, text, tables, forms, and actions to create your own 

stunning sites in Freeway.
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